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1 Purpose of this document 
 This document describes initial installation and configuration processes for introduction of mPLAT 

Suite Base Kit. 

 Please read this document before using mPLAT Suite Base Kit. If there is any unclear, mistake or 

missing information that you find, please feel free to contact us. 

 The contents of this document may be changed without any notice. 

 Copying a part of or full of contents of this document is prohibited by law. 

 "mPLAT”, ”mPLAT Multi-Cloud Conductor” are registered trademarks of Nomura Research Institute, 

Ltd. 

 Windows, Windows Server, Visual Basic, Visual C++, Hyper-V and Active Directory are registered 

trademarks or trademarks of U.S. Microsoft Corporation in U.S. and other countries. 

 Linux is a registered trademark of Mr. Linus Torvalds. 

 All trademark and logo of Red Hat and based on Red Hat are trademarks or registered trademarks 

of Red Hat, Inc in U.S. and other countries. 
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2 What is mPLAT Suite Base Kit? 
mPLAT Suite Base Kit is a solution which Japanese top market share of IT operation management 

tool mPLAT Suite by Co-verification of Nomura Research Institute(abbreviation: NRI). 

The tool provides hardware and software integrated monitoring and management of course, and 

job automation and also service desk function as an optional. Hybrid integrated operation 

management is also available which means that is possible to operate multiple clouds such as 

on-premise and public. 
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3 System Archetecture of mPLAT Multi-cloud Conductor 
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4 Preparation for installation 
4.1 A flow of introduction processes. 

Introduction of mPLAT Suite Base Kit is done as below processes. 

 

(1) Installing mPLAT Browser 

(2) Installing mPLAT Manager(Windows) 

(3) Installing mPLAT Agent(Linux) 

(4) Registration of mPLAT Sensor 

(5) Configuration of Monitoring definition 

(6) Configuration of Message Action and Run Book Automation 

(7) Configuration of Sensor Job 

 

4.2 Advance preparation 

Please get below components before starting the installations. 

 

 Please get a license key from the distributor. For the purpose of trial use, you can 

install it by specifying a trial license in the installer license settings. 

 Please download every kind of modules from Web site of mPLAT Suite(*) 

 (https://mplat.nri.com/download/en/index.html)  

* Authentication is required. 

 

 

https://mplat.nri.com/download/en/index.html
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5 Firststep: Chekcing mPLAT Manager 
 

5.1.1 Checking the connection with mPLAT Manager and the configuration 

 

① Connect from mPLAT Browser to mPLAT Manager (login to mPLAT Manager) 

To open mPLAT Browser, select from Windows Start menu, [All programs] - [mPLAT suite] - [mPLAT 

Browser] - [mPLAT Browser]. 

If it is first time to login from mPLAT Browser after mPLAT Manager installation, then please enter 

Domain and senju to Username and senju to Password. 

 

  

  

After entering Username and Password, 

click [Login] to open mPLAT Browser. 

For the domain, please enter a private IP 

or name resolvable hostname. 
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② Registration for mPLAT Manager Node information 

Open the property of mPLAT Manager Node. 

 

Check the attributes and click OK. 

（Be sure to click OK to close the window.） 
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③ Apply Node Definition 

Select mPLAT domain (Earth icon) and right click → [Apply(Node Definition)]. 

 

 

A window is appeared for applying the Node definition. 
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④ Apply Monitor Attributes 

Select a Node which is applicable and right click → [Apply(Monitor Attributes)]. 

 

 

A window is appeared for applying the monitor attributes. 

 

 

 

  

ｚ 

ｚ 
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⑤ Restart mPLAT system 

Click the icon at the top of mPLAT Browser to launch Global Node Monitor window. 

 

 

To start and stop mPLAT system can be done from Global Node Monitor. 

 

That is all for [Installing mPLAT Manager(Windows)] explanation. 

ｚ 

ｚ ｚ 

ｚ 

Select a target Node. 

Click this icon to start the target Node of 

mPLAT system. 

Click this icon to stop the target Node of 

mPLAT system. 
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5.1.2 Configuration after mPLAT DB component is installed(mPLAT Manager) 

 

Please login to mPLAT DB component installed location with mPLAT running account and operate 

below. 

 

① Restart mPLAT system 

Open Command prompt and restart mPLAT system(sj_halt.exe && sj_boot.exe). 

 

 

 

That is all for [Installing mPLAT DB component] explanation. 
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5.1.3 Usage of Login and user management screen 

 

① Login 

Open Web browser from a PC for Web console, and type in blow URL to the Web browser. 

https://[Hostname or IP address of mPLAT WEB Server]/senju/sjCOM_login.asp 

Notice: Please replace from https to http in the URL if http communication is used. 

Notice: If you specify hostname in the URL, the IP address should be resolved from the hostname. 

If you can access to mPLAT WEB Server without any error, login screen is displayed. 

Otherwise cannot access to there, please make sure the network connection and mPLAT WEB 

Server IP address are correct. 

 

 

 

 

  

Below is the username and password for built-in user. 

•Username ： root 

•Password ： senju 

* Please change built-in user’s password after the configuration is done. 

* Built-in user cannot be deleted. 
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② Create a user 

②-1 Create a domain list 

Define a domain list for mPLAT domain which is used by the user. 

To create the domain list, select from side menu, “Settings” → ”Common Settings” → ”User 

Management” → ”Domain Lists”. 

 

To create new domain list, click [New]. 
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Enter domain list name, description and connected domain, and click [OK] to create the domain list. 

 

 

 

 

 

 

  

Click [Add] on the screen to display a list of domains which are managed by 

the user’s authorities. 

Select and click [OK], then the domain is added to the domain list. 

Enter a user, authentication method and password for each domain. 

And select a default connected mPLAT domain when the user logs in. 
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②-2 Create a service policy 

Define Web console functions as a service policy which the user can use. 

To create the service policy, select from side menu, “Settings” → ”Common Settings” → ”User 

Management” → ”Service Policies”. 

 

To create new service policy, click [New]. 
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Put checks to the functions which the user can use, and remove checks from the functions which 

the user should not use. 

Enter service policy name and description as the last step, and click [OK] to create the service 

policy. 
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②-3 Create a service policy 

Define the user’s authorities as a role. The role is defined as a combination of a domain list and 

service policy. To create the role, select from side menu, “Settings” → ”Common Settings” 

→ ”User Management” → ”Roles”. 

 

To create new role, click [New]. 
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Select a domain list and service policy which the role uses. 

Enter role name and description as the last step, and click [OK] to create the role. 
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②-4 Create a user 

Define an actual login user for Web console. 

To define the user, select from side menu, "Settings" → "Common Settings" → "User Management" 

→ ”Users”. 

 

 

To create new user, click [New]. 
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Enter username and description. Select Password from authentication methods field and type in a 

password. Select Normal User from user type field. And add the role which is created by ②-3. 

After entering above, click [OK] to create the user. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Please follow below rules to define the password 

・7～127 bytes long 

・Include at least two categories from Uppercase, Lower 

case, Numeric and Symbol character. 

・Do not include a string of username. 

Click [Add] to display a role list (The role to which that role is assigned or 

the role created by that role) which is managed by the login user's role. 

Select and click [OK] to add the role to the role list. 
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②-5 Publish API token 

This section describes how to publish API tokens. 

 

When you log in to the Web console as a general user, a red Badge Icon appears at the top 

right of the Domain Information button. 

 

 

This means that the API token is unpublished, and if you use some features of the Web 

console, you will need an API token. 

The procedure for issuing API tokens is as follows: 

 

• Click the "Publish API Token" button on the Domain Information screen. 

 

 

• The "connection domain" on the API token issuance screen displays information about the target 

(domain, mPLAT user) that will issue the API token. Enter your password and click the OK button. 

 

• If the API token is successfully issued, it will be automatically re-logged in and the red Badge Icon 

on the upper right of the "Domain Information" button may not be displayed. 

This is the procedure for issuing API tokens. 
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That is all for [Installing mPLAT WEB component] explanation. 
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6 Registration of mPLAT Sensor 
 

6.1 Before configuring mPLAT Sensor 

 

This describes how to setup a connection and extract information by Windows Management 

Instrumentation(WMI) for Windows mPLAT Sensor. 

Please refer below if other than above mPLAT Sensor setup is required. 

(Setup Guide：[3. Senju Sensor setup]) 

(Users Guide：[2.3.1.4.2. Senju Sensor registration]) 

 

An account connects to mPLAT Sensor should have Administrator authority. And the account should have 

a password defined. 

 

If User Account Control (UAC) function is “ON”, then the situation is as below depends on the OS. 

 Windows Vista and Windows 7 

Using UAC function with “ON” is not supported. 

 Windows Server 2008, Windows 8, Windows Server 2012 and Windows Server 2016 

If you connect using WMI, Administrator account should be specified as a connected user. 

Otherwise it is necessary to put disable to [User Account Control: Turn on Admin Approval Mode] in 

mPLAT Sensor Node, if you use a user who is other than Administrator account to connect. 
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① Changing a security option 

Please change [Network access: Sharing and security model for local accounts] setup to [Classic - 

local users authenticate as themselves] by following path [Control Panel] → [Administrative Tools] 

→ [Local Security Policy],  [Local Policies] → [Security Options]. 

 

 

② Changing Windows firewall setup 

If you use WMI connection from a remote computer which Windows firewall is running, then it is 

necessary to change the Windows firewall setup. 

Please refer Setup Guide：[6.16. Windows Firewall environment setup] for more detail. 
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6.2 Registration of mPLAT Sensor 

 

① HOSTS file configuration in mPLAT Manager installed server 

Open %SystemRoot%¥system32¥drivers¥etc¥hosts file with Notepad ("NOTEPAD.EXE"). 

And add Sensor host name and IP address to the hosts file. 

 

 

② Launching mPLAT Browser 

To open mPLAT Browser, select from Windows Start menu, [All programs] - [mPLAT suite] - [mPLAT 

Browser] - [mPLAT Browser]. 

If it is first time to login from mPLAT Browser after mPLAT Manager installation, then please enter 

senju to Username and senju to Password. 

 

 

  

After entering Username and Password, 

click [Login] to open mPLAT Browser. 
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③ Registration of the sensor 

Right click on the blank space in Node list, and select → [New] → [mPLAT Sensor]. 

 

Enter Node ID, Node name, Type and attributes. And select [mPLAT Sensor(Server)] in Type field. 

 

  

Select [mPLAT Sensor(server)]. 

 

If it is used as a sensor job node, then put a check 

to [Job schedule]. 
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Select [Connection Settings] tab and specify a Probe Node. 

Please specify mPLAT Manager Node ID here. 

After entering the field, press OK（Be sure to click OK button to close the window）. 

 

And other input fields are required in case using monitoring function. 

Please refer Users Guide [4.3.1.9. Node property([Connection Settings]tab)] for more detail. 

 

  

 

Select mPLAT Manager. 
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④ Applying a definition of Node information 

Select mPLAT domain(Earth icon) and right click → [Apply(Node Definition)]. 

 

 

A window is appeared for applying the Node definition. 

 

 

  



6-29 

⑤ Applying Node Monitor Attributes 

Select a Node which is applicable and right click → [Apply (Monitor Attributes)]. 

 

 

A window is appeared for applying the Monitor Attributes. 

 

 

 

That is all for [Registration of mPLAT Sensor] explanation. 
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7 Monitoring definition settings 
 

7.1 Resource monitoring 

 

Resource monitoring monitors below resources for management target Node. 

 CPU usage 

 Virtual memory usage(UNIX/Linux is swap file volume and Windows is Virtual memory) 

 Number of Running processes 

And it monitors Node running status by Ping response confirmation using ICMP packet. 

These monitoring definitions are registered through mPLAT Browser and the monitoring is started. 

It can display the monitoring status for the resources which are registered as targets of monitoring. 

A message is notified in the message monitor when over pre-defined threshold happens as a failure 

detection. 

 

① Settings for monitoring 

For monitoring CPU usage, virtual memory usage, number of running processes and Ping response 

confirmation, you need to access node property. 

From the tree view in mPLAT Browser, select <your Domain> om[Node Group] ou[All]. 

 

 

Then select a node from a list view and right click to display a context menu, and select [Property]. 

Node property is displayed and select [System Information] tab. 
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Enter CPU usage, virtual memory usage and number of running processes fields, 

and put a check to Ping Response Confirmation, and then click [OK]. 

This results to register a monitoring task for CPU usage, virtual memory usage 

and number of running processes monitoring, and starts the monitoring. 

To activate Ping response confirmation setting for the monitoring information, 

please perform [Apply(Node definition)].  

これにより、Ping 応答確認の監視を開始します。 
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② Checking monitoring results 

②-1 Checking by Global Node Monitor 

Click the icon at the top of mPLAT Browser to launch Global Node Monitor window. 

 

Nodes which mPLAT system monitors are displayed as a list and the monitoring results are 

displayed in the system information column. 

 

 

 

 

CPU usage is displayed in CPU column, virtual memory 

usage and total volume of it are in Virtual memory 

column, and total current running processes on the 

Node is in Running processes column. 

 

The result of Ping response is displayed [OK] or 

[NG] in Ping response confirmation column. 
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②-2 Checking a detail by Node Monitor 

Double click on a Node to check the detail by Global Node Monitor. 

 

 

The monitoring results of CPU usage, virtual memory and number of running processes are 

displayed in [System information] tab of Node Monitor. And abnormal, threshold warning, 

monitoring status and extracted time of current results as displayed here are also displayed. 

Current status and the value of each monitoring task are displayed in Node Monitor. Please use 

them as a reference for suitable abnormal and warning threshold setups. 
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7.2 Event log monitoring 

 

It monitors Windows event and a keyword matches with the character string to display as a message. 

It needs to create a monitoring method and register together with actual event log name by 

management target Node. 

 

① Registration monitoring definition of event log file 

From the tree view in mPLAT Browser, select ＜Domain＞→ [Filter]→ [Event Log Filter]. 

 

 

  

Right click on the blank space in the list view to display 

context menu and select [New] menu. 

Then event log property is displayed. 
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Enter event log filter name, regular expression type, sending type and/or other fields and click [OK]. 

Event log filter is registered by doing this. 

 

 

② Adding filter monitoring item 

Filter monitoring item registration can be done after creating event log filter. Filter monitoring item 

is a definition to perform filtering for a keyword. 
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From the tree view in mPLAT Browser, select ＜Domain＞→ [Filter]→ [Event Log Filter]→ ＜

Event Log Filter＞ and select an event log filter to register a filter monitoring item. 

 

 

Enter process switch, sending message ID, judgment condition and/or other fields and click [OK]. 

Monitoring item is added to [Process Order] frame list in log filter property by doing this. 

 

  

Right lick on the blank space in the list view to display 

context menu and select [New] menu. Then filter 

monitoring item property is displayed. 
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③ Registration of event log to management target Node 

Monitoring target event log registration is done through Node property. Please select [Log 

Monitoring] tab in Node property. 

 

Enter monitoring target event log type and monitoring method, and click [OK]. Monitoring target 

event log is registered by doing this. 

 

 

 

Put a check to [Event log monitoring] and click 

[Add]. 
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To apply the setup done through [Log monitoring] tab to monitoring information, select and right 

click a Node from the tree view in mPLAT Browser to display context menu, and perform  [Apply 

(Monitor Attributes)]. 
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7.3 Text log monitoring 

 

It monitors output log file which is text format and a keyword matches with the character string to 

display as a message. 

It needs to create a monitoring method and register together with actual log file name by management 

target Node. 

 

① Registration monitoring definition of log file 

From the tree view in mPLAT Browser, select ＜Domain＞→”Filter”→”Log filter”. 

 

Enter log filter name, sending type and/or other fields and click [OK]. Log filter is registered by 

doing this. 

Right click on the blank space in the list view to display 

context menu and select [New] menu. Then log filter 

property is displayed. 
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② Adding filter monitoring item 

Filter monitoring item registration can be done after creating log filter. Filter monitoring item is a 

definition to perform filtering for a keyword and a way to display a message. 

From the tree view in mPLAT Browser, select ＜Domain＞→ [Filter]→ [Log Filter]→ ＜Log Filter

＞ and select a log filter to register a filter monitoring item. 

 

 

Enter process option, outgoing message ID, additional message, judgment condition and /or other 

fields and click [OK]. Monitoring item is added to [Process order ] frame list in log filter property by 

doing this. 

 

Right click on the blank space in the list view to display 

context menu and select [New] menu. Then filter 

monitoring item property is displayed. 
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③ Registration of log file to management target Node 

Monitoring target log file registration is done through Node property. Please select [Log 

monitoring] tab in Node property. 

 

 

  

 

 

Put a check to [Log monitoring] and click [Add]. 



7-43 

Enter monitoring target path name and its file name, using regular expression, monitoring method 

and character code, and click [OK]. Monitoring target log file is registered by doing this. 

 

To apply the setup done through [Log monitoring] tab to monitoring information, select and right 

click a Node from the tree view in mPLAT Browser to display context menu, and perform  [Apply 

(Monitor Attributes)]. 

 

 

That is all for [Monitoring definition settings] explanation. 
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8 Message action and Run book automation settings 
 

8.1 Message action and Run book automation overview 

 

Summary of Message action and Run book automation 
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Message action 

Message action is a function which can perform predefined actions automatically when predefined 

messages as conditions are output. 

 

 

An example of Message action screen 
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Run book automation 

Run book automation is a function which automates direct operation tasks (like contents of output 

or timing which requires user’s decision) followed to process document when the events happen. 

 

 

An example of Run book automation screen 
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8.2 Message action settings 

 

① Determining Management plan 

Before using automation, following points to be determined. 

 

①-1 Determining general settings for Message action 

Message rule applicable condition and duplicated message judgement to be determined. 

 

①-2 Determining last action 

The action when a message does not match with any of each rule defined to be determined. 

 

(See Users Guide：[3.2.3.2.3 Message action settings]) 

 

② Determining Message action contents 

Message conditions for applicable actions to be determined. 

 

②-1 Determining general settings for each rule 

Defined name, effective start/end date and priority for a rule to be determined. 

 

②-2 Determining conditions 

A rule is applicable when output message matches with predefined condition. 

Multiple conditions can be selected. 

 

②-3 Determining actions 

Configuration for handling type and an action when output message matches with a condition. 

An action can select from below items. 

●Sending email ●Phone call ●Executing commands ●Executing run book 

 

②-4 Determining output messages 

Configuration to display a message on message monitor when output message matches with a 

condition. 

 

(See Users Guide：[3.2.3.2.5 creating a rule]) 
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③ Creating a definition 

Creating a definition based on the decision and starting monitoring. 

 

③-1 Creating a rule 

A rule is a definition what action to execute or changing output message for a condition. A rule is 

created through mPLAT Browser. 

From the tree view in mPLAT Browser, select ＜Domain＞→[Event]→[Automation]→[Message 

action] →＜Rule group ID＞. 

 

General tab defines rule name, effective start/end date and others for the registration. 

 

Right click on the blank space in the list view to display context 

menu and select [New] menu. 

Then create new rule property is displayed. 
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Action tab defines an action when output message matches with a condition. 

5 types of action are available and can be chosen any of them or all of them. 

 Sending email(specific email address) 

 Sending email(specific email template) 

 Phone call 

 Executing commands 

 Executing run book 

(See Users Guide：[3.2.3.2.5 Creating rule]) 

 

 

Notice: In case of sending email and phone call 

Using sending email(specific email address), sending email(specific email template) and phone call 

requires an environment which is prepared for those functions. 

(See Setup Guide：[6.22. Sending email(specific email address) for Message action function setting]) 

(See Setup Guide：[6.23. Sending email(specific email template) for Message action function 

setting]) 

(See Setup Guide：[6.24. Phone call setup]) 
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③-2 Simulating a rule 

A simulation is performed using the message log for the general settings for message action, the 

rule group, and rules with the rule simulation function. With this function, you can confirm how 

will the message action operate when messages arrive. 

From the tree view in mPLAT Browser, select ＜Domain＞→  [Event]→  [Automation]→ 

[Message action], and right click to display context menu, and then select [Simulating a rule]. 

 

Enter a message log or a path for a message log used for the simulation in the message log from, 

select the detail level for the output file and click OK. then the simulation results will be output 

to the file path which is defined the simulation results form. 

 

 

See Users Guide：[11.3.2.1.4. Message log] regarding the message log. 

See below for other Message action settings. 

See Users Guide ：[3.2.3.5. Create Contact Group] 

See Users Guide ：[3.2.3.4 Mail Contact Creation] 

See Users Guide ：[3.2.3.6 Run Book Automation[EXTENSION]] 
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8.3 Run book automation settings 

 

Structure of Run book automation 

 

 

In the run book automation, dependencies are put to multiple sections, chapters and branches. And 

assembles them as a single execution unit. 

The followings are the components that comprise run book automation. 

 Section: Minimum unit (such as commands and shell scripts) 

 Chapter: A group of sections 

 Branch: It defines launch conditions for each section, chapter and branch 

There are 5 types of branch conditions. 

End-Code-Branch, Result-Branch, Env-Var-Branch, Schedule-Branch and Manual-Branch 

 Parallel chapter: A group of sections for parallel execute 

 Book linked section: A section which issues a specific book as registered executable book  

 Book: A combination of several sections, chapters and branches 

 Target book: A registered executable book which a book submitted through Message action. 
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Register Run book automation definition to perform it, and check the results. 

Please follow below steps to configure for actual operation. 

 

① Creating a template group and template 

Creating a section template for base operation. 

 

Template groups are things that define groups that manage section templates. A section template 

sets the information for the launch command sequence for the section, parameters, judgment 

conditions and process documents. 

A section can be created simply by entering the necessary parameters to register a section using a 

section template and without entering complex commands or knowing any command sequences. 
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①-1 Creating a template group 

A template group is created through mPLAT Browser. 

From the tree view in mPLAT Browser, select ＜Domain＞→[Event]→[Automation]→[Run Book 

Automation]→[Section Template]. 

 

 

When each field is filled, click [OK] to complete the template group creation. 

 

 

 

  

A list shows template groups which are already created. A 

template group can be created, modified and deleted 

here. 

Right click on the blank space in the list view to display 

context menu and select [New] menu. 
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①-2 Creating a section template 

A section template is created through mPLAT Browser. 

From the tree view in mPLAT Browser, select ＜Domain＞→[Event]→[Automation]→[Run Book 

Automation]→[Section Tamplate]→＜Template Group Name＞. 

 

 

When each field is filled, click [OK] to complete the section template creation. 

 

(See Users Guide：[3.2.3.6.4 Creating Template groups and Section templates]) 

A list shows section templates which are already created. 

A section template can be created, modified and deleted 

here. 

Right click on the blank space in the list view to display context menu and select 

[New] menu. 
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② Creating books 

Book groups and books are created here. 

 

A book is a grouping of sections, chapters and branches. Operations can be performed by 

registering sections, chapters and branches to a book. Multiple books can be created for different 

users. A book group is defined as a group that manages books. A book group is  created and a 

book is registered afterwards. 

 

(See Users Guide：[3.2.3.6.4 Creating Template groups and Section templates]) 
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②-1 Creating a book group 

From the tree view in mPLAT Browser, select ＜Domain＞→[Event]→[Automation]→[Run Book 

Automation]→[Book Group]. 

 

 

 

When each field is filled, click [OK] to complete the book group creation. 

 

 

 

  

A list shows book groups which are already created. A 

book group can be created, modified and deleted here. 

Right click on the blank space in the list view to display context menu and select 

[New] menu. 
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②-2 Creating a book 

From the tree view in mPLAT Browser, select ＜Domain＞→[Event]→[Automation]→[Run Book 

Automation]→[Book Group]→ ＜Book Group Name＞. 

 

When each field is filled, click [OK] to complete a book creation. 

Sections, chapters and branches must be registered to the created book through Run book editor. 
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General settings 

Information such as the book name, effective date, enable/disable, required time monitoring, cut 

off time and procedures are set with [General] tab. 

(See Users Guide：[3.3.2.5 Run book automation]) 

 

Start condition settings 

To set execution suppression, set from [Start Condition] tab after setting [General] tab. 

(See Users Guide：[3.3.2.5 Run book automation]) 

 

Environment variable settings 

To specify an environment variable in a book, set it from [Environment Variable] tab after setting 

[General] tab. 

(See Users Guide：[3.3.2.5 Run book automation]) 
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③ Creating executable book 

Contents of a book are created through Run book editor. 

Run Book Editor is a function to visually confirm and create the structure for sections, chapters and 

branches in a book. 

Even complex books can be edited easily using the visual display. 

 

③-1 Registration of a section 

In mPLAT Browser, select [Tool] → [Run Book Editor] menu to start Run Book Editor. 

A section is registered to a book through Run Book Editor . 

To register a section to a book, click [Section] in Run Book Components toolbar and left-click in run 

chart area to display section template list screen. 

Select a section which you want to register from the screen. 

(See Users Guide：[3.2.3.6.5.7. Registration a session to a book through Run Book Editor]) 
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Please fill in each item in ［Advanced Setting］ tab, ［Environment Variables］ tab, ［Running Node］ 

tab, if necessary. 

 

 

There are different ways to define [Running Node] tab that depends on a Node (mPLAT Manager or 

mPLAT Sensor) executes a section. 
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In case of executing mPLAT Manager 

 

 

  

Enter mPLAT Manager Node ID to [Specified Node] for the 

Node that executes commands. 

Put a check to [Local Execution]  in Connection Method to 

Running Node, and click OK. 
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In case of executing by mPLAT Sensor 

 

 

 

 

 

 

  

Put a check to [Remote Execution] in Connection Method to Running 

Node. 

Enter mPLAT Manager Node ID to [Probe Node] and select [Connect 

via TELNET] for connection method of Node to execute a command. 

Enter Username and Password that the user exists in executed Senju 

Sensor Node. 
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③-2 Registration of Book linked section 

To register a book linked section to a book, click [Book Linkage Section] in Run Book Components 

toolbar and left-click in run chart area as same as registration of a section to display book linked 

section property window for setup. 

When each field is filled, click ［OK］. 

(See Users Guide：[3.2.3.6.5.8. Registration of book linked section by Run book editor]) 
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③-3 Registration of a branch 

To register a branch to a book, click [Branch] in Run Book Components tool bar and left-click in run 

chart area as same as registration of a section to display branch list screen. Select a branch you 

want to register from the branch list screen. 

When each field is filled, click [OK]. 

 (See Users Guide：[3.2.3.6.5.9. Registration of a branch to book through Run Book Editor]) 

 

 

 

③-4 Registration of a context through Run Book Editor 

The sections, chapters and branches in a book must always have context attached. The edited 

content cannot be saved for a section, chapter or branch that exists without an attached contextual 

relationship. 
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To create precedence relationships, first click [Order] in Run Book Components toolbar. Then of the 

two components in run chart area, select the component that you want to come first, and then 

select the component you want to follow it. 

A line indicating a precedence relationship is drawn between the two items. 

Multiple connections cannot be set for sections and chapters. Multiple connections can only be set 

for branches. 

(See Users Guide：[3.2.3.6.8.1 Branch]regarding branches. 

A context cannot be added to sections in parallel chapter. 

 

If you leave the edited contents so far cannot be saved automatically, so please save the edited 

contents to select ［File］→［Save］ menu. 
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④ Books and Branches validation 

Run Book Checker can validate Branches in books which are currently registered. 

Branch validation can prevent errors by mistakes such as mis-setup before actual operation to see 

how the branch will behave and which succeeding section will perform. 

A book is displayed which belongs to selected [Book] from the browser in the tree view. 

(See Users Guide：[3.4.3.1 Outline of Run Book Checker]) 

 

 

 

That is all for [Message Action and Run Book Automation settings]explanation. 
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9 Sensor Job settings 
 

9.1 Job Schedule overview 

 

Job Schedule overview 

Job Schedule is a subsystem that unifies management and controls execution of jobs running in a 

management system on operation management servers. 

By creating calendars that define operation days, you can plan job operations. 
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9.2 Job Schedule settings 

 

Job Schedule components 

 

 

In the Job Schedule subsystem, dependency relationships are created among multiple jobs and nets, and 

groups of jobs and nets are set as single execution units. 

The elements which comprise Job Schedule are as follows. 

 Job：Minimum unit（such as commands and shell scripts） 

There are two types of jobs. 

Job and Branch job 

(See Users Guide：[5.2.4.6. Creating Jobs and Nets]) 

 Net：A group of jobs. It is possible for nets to exist within nets. 

There are 5 types of nets. 

Net, Repeat net, Net on abnormal state and Branch succeeding net 

(See Users Guide：[5.2.4.6. Creating Jobs and Nets]) 

 Frame：A combination of several jobs and nets which is executed job unit. 
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 Operating environment：Defines the Node name (Probe Node name and connection settings in case 

of mPLAT Sensor), username and environment variables for the jobs and nets.  

When jobs and nets are created, relationships are created between them. 

(See Users Guide：[5.2.4.1. Creating Operating environment]) 

 Job calendar：Calendar that sets job operation days and non-operation days for one year. 

(See Users Guide：[5.2.4.3. Creating Job calendar]) 

 Trigger：Defines the start conditions for each the jobs and nets. 

There are 3 types of triggers. 

Event waiting trigger, File waiting trigger and frame linked trigger. 

(See Users Guide：[5.2.4.4. Creating Triggers]) 

 Resources：Defines the start conditions for each the jobs and nets. 

To run jobs and nets for which resources are specified, a set number of resource usage values are 

required, and if resources cannot be allocated, starting is suppressed until the resources are 

acquired. 

(See Users Guide：[5.2.4.5. Creating Resources]) 

 System：A group of administratively related frames. 

(See Users Guide：[5.2.4.7. Creating Systems and Registering Nets]) 

 Target system：A system that is actually running. 

(See Users Guide：[5.2.5.3. Creating Target systems]) 
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Define Job Schedules and execute, and check the results. 

Please follow below configuration steps for actual operation. 

Notice：Please register Sensor Node before doing this configuration. 

 

Operation for planning and preparation. 

 

① Creating an operating environment 

Operating environment is a definition which has the Node name, username, concurrently running 

jobs and environment variables for the jobs and nets. 

In case of mPLAT Sensor, probe name and connection settings are added to above definition. 

When jobs and nets are created, operating environment name is specified which the jobs and nets 

run. 
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①-1 Creating Job Environment 

Job Environment is created through mPLAT Browser. 

From the tree view in mPLAT Browser, select ＜Domain＞→[Job Schedule]→[Job Environment]. 

 

 

When each field is filled, click [OK] to complete the template group creation. 

(See Users Guide：[5.2.4.1. Creating Operating environment]) 

 

  

A list shows operating environments which are 

already created. An operating environment can be 

created, modified and deleted here. 

Right click on the blank space in the list view to display context menu and select [New] 

menu. Senju Agent/Senju Sensor will be displayed and select Senju Sensor from there. 
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② Creating Job calendar 

The job calendar specifies the operating days and off days for jobs/nets/frames and is created in 1 

year units (with the creation of multiple years possible). 

 

②-1 Creating Business day calendar 

Business day calendar which is required for creating job calendar is created through mPLAT 

Browser. 

From the tree view in mPLAT Browser, select ＜Domain＞→[Calendar]→[Business Day Calendar]. 

 

When each field is filled and business days and non business days are specified, click [OK]. 

(See Users Guide：[2.4.10.3. Business Day Calendar]) 

 

A list shows business day calendars which are 

already created. A business day calendar can be 

created, modified and deleted here. 

Right click on the blank space in the list view to 

display context menu and select [New] menu. 
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②-2 Creating Job calendar 

From the tree view in mPLAT Browser, select ＜Domain＞→”Job Schedule”→”Job Calendar”. 

 

 

When each field is filled and conditions are specified, click [OK]. 

(See Users Guide：[5.2.4.3. Creating Job calendar]) 

  

A list shows job calendars which are already 

created. A job calendar can be created, modified 

and deleted here. 

Right click on the blank space in the list view to 

display context menu and select [New] menu. 
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③ Creating a Job and Net 

A job is the smallest running unit in the Job Schedule subsystem and can be a command, a shell 

script made up of multiple commands or others. 

Multiple jobs can be created for different users. 

A job is registered to a net to operate. A single job can be registered to multiple nets. 

A net is a group of jobs with a fixed execution order (dependency relationship). The net cannot only 

have jobs, but a dependency relationship can be created. 

 

Create base jobs and nets for job operations, and create relationships between the job calendar 

that defines operation days and the operating environment that runs them. 

 

The steps for creating jobs and nets are as follows. 

 Job development 

Consider the following when developing a job. 

 Ending condition(how to determine a normal end and abnormal end) 

 Job running order(net structure) 

 Job operating environment 

 Creating Job 

Job is created through mPLAT Browser. Specify the name for job and register the launch 

command line.  Also, associate job environment. 

 Creating Net 

Net is created through mPLAT Browser. Specify the name for the net and register the jobs and 

nets that will comprise the net. 

Specify any jobs that must run before that job (precedent jobs) as the time of registration. 

Also, associate the jobs and nets that will comprise this net with a job calendar and operating 

environment. 

(See Users Guide：[5.3.1.8. Net.Effective Date]) 

(See Users Guide：[5.4.1. Job Editor]) 
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③-1 Creating a Job and Net 

A Job is created through mPLAT Browser. 

From the tree view in mPLAT Browser, select ＜Domain＞→[Job Schedule]→[Job]. 

 

When each field is filled, click [OK]. 

(See Users Guide：[5.3.1.7. Job]) 

 

A list shows jobs which are already created. A job 

can be created, modified and deleted here. 

Right click on the blank space in the list view to 

display context menu and select [New] menu. 
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③-2 Creating a Net and registration of a Job 

A Net is created through mPLAT Browser. 

From the tree view in mPLAT Browser, select ＜Domain＞→”Job Schedule”→”Net.Effective Date”. 

 

 

When each field is filled, click [OK]. 

(See Users Guide：[5.3.1.8. Net.Effective Date]) 

 

  

A list shows nets which are already created. 

A net can be created, modified and deleted 

here. 

Right click on the blank space in the list view to 

display context menu and select [New] menu. 
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Register the job to the net. 

In the tree view in mPLAT Browser, the net which is created by previous step appears 

under ”Net.Effective Date”, and select it. 

Right click on the blank space in the list view to display context menu and select [New] menu. 

A job and net in the net can be registered, modified and deleted here. 

Right click on the blank space in the list view to display context menu and select [New] menu. 

Job/Net/Node Group Net/Repeat Net/Net on Abnormal State menu appears and select Job from 

there. 

 

When each field is filled, click [OK]. 

(See Users Guide：[5.3.1.8.1. Net.Effective Date(Registration)]) 
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④ Creating a System and registration of a Net 

Systems are operation groups that become units for date changes, making them groups of 

administratively related frames. 

You can make these systems into units. And use them to submit jobs and change their dates. 

 

 Creating a System 

Specify System name for registering the Net thorough mPLAT Browser. 

(See Users Guide：[5.3.1.9. System]) 

 

 Registration of a Net 

Register the net to the created system. At this time, specify the Job Calendar, Start Time and 

Start Date to be used for the registered net. 

And if necessary, set up Operating Environment and the Required Time, and define the net 

end time command. 

(See Users Guide：[5.3.1.9.1. System(Registration)]) 
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④-1 Creating a System 

A System is created through mPLAT Browser. 

From the tree view in mPLAT Browser, select ＜Domain＞→[Job Schedule]→[System]. 

 

When each field is filled, click [OK]. 

(See Users Guide：[5.3.1.9. System]) 

 

A list shows systems which are already 

created. A system can be created, modified 

and deleted here. 

Right click on the blank space in the list view to display 

context menu and select [New] menu. 
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A System is created through mPLAT Browser. 

In the tree view in mPLAT Browser, the System which is created by previous step appears under 

“System”, and select it. 

A net for the system can be registered, modified and deleted here. 

Right click on the blank space in the list view to display context menu and select [New] menu. 
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Operations for day-to-day operation. 

 

① Job/Net/Frame scheduling 

For each operation date, check the net to be started on the date and their start times, register that 

as a frame and schedule jobs/nets. 

The specified operation date for staring the frame and the start time are registered in the schedule. 

If each of the operation dates for the items is not registered, the jobs and nets cannot operate. 

Please perform this operation at least the day to prior to the operation day. 

 

 Creating target system 

All systems as a group, individual system and each individual frame can be registered for the 

frame that will start on the operation date from the registered net and the job calendar. 

Confirm the job schedule and perform the registration. Frames can be added, modified or 

deleted as necessary at this time. 

 

② The day operating process 

Confirm the schedule for the jobs/nets/frames running today on the target system and submit 

them to mPLAT system. 

The submitted jobs/nets/frames will automatically start at the start time. 

The target system initialization and date change processing will be performed once the 

jobs/nets/frames have ended. 

 

The flow for normal operations is as follows. 

 System registration status 

The frame registration status for the day job schedule for the target system is confirmed. 

Frames can be added or deleted as necessary at this time. 

(See Users Guide：[5.3.1.12.1.3. Target system]) 

 

 System submission 

Submit the target system if the day schedule is correct. 

The frames in the submitted system will automatically start at the start time. 

 (See Users Guide：[5.4.3. Job Monitor]) 
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 Frame activation status 

The activation status of the jobs/nets/frames can be confirmed from the activation status 

monitor screen (Job Monitor) while the jobs/nets/frames are operating. 

Also, jobs/nets/frames can be managed according to their status. 

(See Users Guide：[5.4.3. Job Monitor]) 

 

 System initialization 

The target system will be initialized once all jobs, nets and frames have completed. 

Initialization means that the status for all jobs/nets/frames on the target system will return to 

Not Submitted (initialized status). 

The execution status of jobs/nets within a frame that was submitted is preserved as of that 

time. 

To re-run ended jobs/nets/frames at that point, it is necessary to return the running status to 

the initial status. 

Please always initialize once the work is completed. 

(See Users Guide：[5.4.3. Job Monitor]) 

 

 Date change 

Date change processing is done for the initialized target system. Date change is where the 

operation date for the target system is changed to the operation date for the next operation. 

Date change is done at the target system level. 

(If you perform the date change process for the target system that is not initialized (status 

other than not submitted) at this time, the target system with the previous operation date will 

remain and a target system with the date to perform the next operation will be created. 

Delete the target system for the previous operation data after the job/net/frame has ended 

and after initialization.) 

(See Users Guide：[5.4.3. Job Monitor]) 
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②-1 Creating a Target system 

A Target system is created through mPLAT Browser. 

From the tree view in mPLAT Browser, select ＜Domain＞→[Job Schedule]→[System]. 

 

 

After entering Operation Date, click [OK]. 

 

 

  

Select a created system from the list view and right 

click to display context menu, and select [New] menu. 
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②-2 Checking a Target system 

Check a Target system 

From the tree view in mPLAT Browser, select ＜Domain＞→[Job Schedule]→[Operation Date]. 

The list view in mPLAT Browser shows created Operation Dates for now as a list. 

In the tree view in mPLAT Browser, the Operation Date which is created by previous step appears 

under "Operation Date", select it and select “Target System” below of it. 

Make sure that the Target system which is created by previous step appears under ”Target system” 

in the tree view in mPLAT Browser. 

 

 

(See Users Guide：[5.3.1.12.1.3. Target system]) 

 

  

A list shows frames which are already created. A frame can be 

modified and deleted, and also perform operations such as 

submit initialize and force stop here. 
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②-3 System submission 

Submit the prepared target system. 

 

In mPLAT Browser, select [Tools] -> [Job Monitor] menu. 

 

 

In Job Monitor, select [File] -> [Target System] menu. 
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The list at the top is a list of available target systems, and the list on the bottom is a list of selected 

target systems. 

In this dialog box, first select an Operation Date for the target system just created, select a target 

system in the top list, and click [Add] to add the frame to the bottom list. 

 

 

In the tree view, select the target system that includes the frame to be submitted or select the 

frame itself and select [Frame] tab. 
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Select a Frame to be submitted from frame list displayed in 

[Frame] tab, and right click to display context menu and select 

[Submit]. 
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When each field is filled, click [OK]. The frame submission will be successful and the frame status 

changes to ”Waiting” or ”Awaiting Start”. 

 

 

(See Users Guide：[5.4.3. Job Monitor]) 

 

  

Selecting [Immediately] to start the 

frame immediately. 
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②-4 Frame running status 

Confirm the target system and frame running status. 

 

From the tree view in Job monitor, select target system and select [Frame] tab. 

 

 

In the tree view, select the Frame and select [Run Chart] tab. 
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(See Users Guide：[5.2.5.5. Frame running status confirmation]) 

(See Users Guide：[5.4.3. Job Monitor]) 

  

If you set up Frame Monitor Advanced Settings, 

the status of the jobs and nets within the frame 

that was set up is displayed. 

The Jobs, nets and triggers within the frame are 

displayed. 
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②-5 Target System initialization 

Select a target system that has ended in list view in Job Monitor and right click it to display the 

context menu, and then select [Initialize] menu. 

 

 

 

 

 

②-6 Change Date 

Select a target system that has initialized in the list view and right click it to display the context 

menu, and then select [Change Date] menu. 

When Operation Date is filled, click [OK]. 

 

 

 

That is all for [Sensor Job settings] explanation. 

 

 

 

 

If it ended normally, select Normal Initialization and click OK to initialize. 

If it is not ended normally, select Forced Initialization and click OK to initialize. 

The next date for operations can be 

specified for the target system. 
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10 Installing mPLAT Agent(Linux) 
 

10.1 Before installing mPLAT Agent(Linux) 

 

Notice. Please refer [Release note:[3.1.7. mPLAT Agent operating environment(Linux)]] and 

[Installation Guide:[5.1.3.1. About OS patches]] for installable OS, install options and necessary 

packages. 

Notice. You should be able to connect to mPLAT Manager installed environment. 

Notice. Only half-width (1-byte) alphanumeric characters are available for the hostname and set 

within 63 bytes. 

 

① HOSTS file configuration in mPLAT Manager installed server 

Open %SystemRoot%¥system32¥drivers¥etc¥hosts file with Notepad ("NOTEPAD.EXE"). 

And add Agent host name and IP address to the hosts file. 

 

② HOSTS file configuration in the target server to install mPLAT Agent 

Login to the server by root account(root), Open ”/etc/hosts” file with e.g. vi editor. 

Add mPLAT Manager domain name, its IP address, own hostname and its IP address to the hosts 

file. 

(hosts file) 

  

 111.111.111.111 mydomain  # mPLAT manager 

 111.111.111.112 mynode1   # mPLAT agent 
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③ Create mPLAT Agent running account 

Login to the server as root account(root), and create an account which will run mPLAT Agent. 

(Example) 

 

 

④ About default communication restrictions 

The communication used by mPLAT system might be disabled due to the OS settings.  The main 

reason why the communication used by mPLAT system is disabled is as below.  

 The firewall function is enabled and this restricts the communication used by the mPLAT 

system. 

In order to mPLAT system to perform communications, this function and restriction must either be 

disabled, or the restriction must be relaxed by setting it appropriately.  

(See release note：[4.1.1.10. Protocols / Port numbers]) 

 

  

adduser -s /bin/bash senju 

Login shell should be bash or csh. 
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10.2 Installing mPLAT Agent (Linux) 

 

① Place a package 

Place mPLAT agent package of mPLAT system into the home directory of mPLAT Agent running 

account. 

 

② Login 

Login as mPLAT Agent running account. 

 

③ Change the installer permission 

Allow execute permission to the installer. 

 

 

④ Change the login account 

Change the login account to root. 

 

  

chmod +x mplat_agt-1800-*nn*-linux-x86-*nnnnnnnn*.bin 

Please specify mPLAT Agent package. 
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⑤ Run the installer 

Move to the home directory of mPLAT Agent running account, and run the installer. 

 

Notice: “#” is a leading of the line. Please type in without “#” when you execute the command. 

 

The screen asks to run the installer, please enter Y and press Enter to start the installer. 

 

 

⑥ Specify mPLAT running account 

Specify mPLAT running account. Please type in registered mPLAT account name, and press Enter. 

 

 

⑦ Specify Node ID 

Specify Node ID. Please do not enter anything here and make sure server name is in the brackets, 

and press Enter. 

 

 

⑧ Specify long host name 

---- mPLAT Node ID ------------------------------------------------------------- 

Please enter the mPLAT Node ID.  

mPLAT Node ID [mynode1] :  

---- mPLAT Service Account Name ------------------------------------------------ 

Please enter a local account that runs the mPLAT service.  

User Name [senju] :senju 

******************************************************************************** 
                    Welcome to the mPLAT Agent Setup Wizard 
                       mPLAT Multi-Cloud Conductor 2018 
               Copyright (C) 2018 Nomura Research Institute, Ltd.. 
******************************************************************************** 
This program will install the mPLAT Agent version 18.0.0 on your server. 
You are recommended that you finish any other installers before continuing. 
Are you ready to continue? [Y/n] : 

# cd <mPLAT home directory> 

# <mPLAT home directory>/mplat_agt-1800-nn-xxxxxx-xxxx-nnnnnnnn.bin 

Please specify mPLAT Agent package. 

Enter Y. 

Type in mPLAT running account. 

Make sure the server name is in there. 



10-97 

Specify long host name. Please do not enter anything here and just press Enter. 

 

 

⑨ Specify domain name 

Specify domain name. Please enter mPLAT Manager Node ID and press Enter. 

 

 

⑩ Specify installation directory 

Specify installation directory. Please make sure the home directory of mPLAT Agent running 

account is in the brackets and press Enter. 

 

 

⑪ Specify a character code 

Please specify a character code by the number to be used and press Enter. 

(if it is blank, then en_US is used as a default character code) 

 

 

  

---- mPLAT Character Code ------------------------------------------------------ 

 Please select your language for initial data configuration. 

 [1] en_US 

Please choose an option [1] : 

---- Installation Directory ---------------------------------------------------- 

 Please select a directory to install the mPLAT Agent. 

 SENJUHOME [/home/senju] : 

---- mPLAT Domain Name --------------------------------------------------------- 

 Please enter the mPLAT Domain Name. 

 mPLAT Domain Name [N/A] : mydomain 

---- mPLAT Long Host Name ------------------------------------------------------ 

 Please enter the mPLAT Long Host Name. 

 mPLAT Long Host Name [N/A] :  

Enter Manager Node ID. 

Make sure the home directory of mPLAT 

running account is in there. 

Enter a character code number. 



10-98 

⑫ Specify output system log 

Specify mPLAT Agent log to output as OS system log or not. Please put N and press Enter. 

 
 

⑬ Confirmation for the installation 

Please make sure the configuration. If it is as expected, then put Y and press Enter after your 

confirmation. 

 
 

⑭ Start the installation 

The installation gets started. 

 

  

INFO : Setup is now ready to begin installing the mPLAT Agent on your server. 
INFO : Please wait while setup installs the mPLAT Agent on your server. 
INFO : Checking specified value... 
INFO : Checking OS settings... 
INFO : Checking user... 
INFO : mPLAT package [/root/mplat_agt-1800-00-linux-x86-20180202.bin] 
INFO : Extracting the mPLAT package... 
Extracting : [##################################################]  547/547 
 .. 
 .. 
 .. 
INFO : The mPLAT Agent installation is completed successfully. 
    (Install log: /home/senju/log/senju_agt_yyyymmddhhmmss_setup.log) 
  

 ---- Summary ------------------------------------------------------------------- 
 
mPLAT User Settings 
  User Name      [senju] 
  Home Directory  [/home/senju] 
 
Global Settings 
  Package Type    [Agent] 
  Domain Name  [mydomain] 
  Node ID         [mynode1] 
  Long Host Name  [N/A] 
  SENJUHOME     [/home/senju] 
  Language        [en_US] 
  System Logging   [Disabled] 
 
Is the selection above correct? [Y/n] :  Y 

---- Logging System Error Messages --------------------------------------------- 

 Please configure syslogd configuration file. 

 Do you want to log the system error messages to the log file? [y/N] : N Put N. 

Put Y. 
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10.3 Checking the connection with mPLAT Agent and the configuration 

 

① Launching mPLAT Browser 

To open mPLAT Browser, select from Windows Start menu, [All programs] - [mPLAT suite] - [mPLAT 

Browser] - [mPLAT Browser]. 

If it is first time to login from mPLAT Browser after mPLAT Manager installation, then please enter 

senju to Username and senju to Password. 

 

 

 

  

After entering Username and Password, click [Login] 

to open mPLAT Browser. 
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② Registration of the agent 

Right click on the blank space in Node list, and select → [New] → [mPLAT Agent]. 

 

 

Enter Node ID, Node name, Type and Attributes, and click OK（Be sure to click OK button to close 

the window.）. 
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③ Applying a definition of Node information 

Select mPLAT domain(Earth icon) and right click → [Apply(Node Definition)]. 

 

 

A window is appeared for applying the Node definition. 
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④ Applying Node Monitor Attributes 

Select a Node which is applicable and right click → [Apply (Monitor Attributes)]. 

 

 

A window is appeared for applying the Monitor Attributes. 
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⑤ Restarting mPLAT system 

Click the icon at the top of mPLAT Browser to launch Global Node Monitor window. 

 

 

To start and stop mPLAT system can be done from Global Node Monitor. 

 

 

That is all for [Installing mPLAT Agent (UNIX)] explanation. 

 

Select a target Node. 

Click this icon to start the target Node of 

mPLAT system. 

Click this icon to stop the target Node of 

mPLAT system. 
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mPLAT Suite Information Center 

senjuinfo@nri-itsa.com 

http://mplat.nri.com 
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